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1 INTRODUCTION 

DMX (Digital Multiplex) is a control protocol in the event technology and therefore has a solid, reliable 
and simple design. The standard in its current form has existed since 1990. Due to its popularity, it 
offers a wide range of functions at low acquisition costs.  
 
The DUODMX GATEWAY has a network interface (LAN and WLAN, depending on the variant) and two 
independently configurable DMX outputs (DMX worlds) with 512 channels each, allowing you to 
control, for example, two rooms/areas separately.  
The DUODMX GATEWAY can be operated as a DMX master or slave. The gateway sends DMX packets in 
master mode and receives them in slave mode.  
Nine different device variants position the DUODMX GATEWAY ideally for usage in almost any required 
scenario. The device is used as DMX gateway for KNX® or EnOcean® systems but can also be operated 
as a standalone device – straight with a native App for iOS® and Android® smartphones for particularly 
easy operation. 
 
The professional configuration software not only enables you to dim individual channels, but also to 
program complex sequences.  
 
The DUODMX GATEWAY is highly suitable for subsequent installation as a device installed in the ceiling. 
A corresponding adapter is available for top DIN rail installation.  
In addition to the recessed ceiling version, the DUODMX GATEWAY is also available as REG (Modular 
device (REG) housing 4 units). 
 
 

2 THE GATEWAY 

The DUODMX GATEWAY is a ceiling installation device, and its compact size also enables specific 
installation situations. The REG variant (Modular device housing), on the other hand, is for installation in 
distribution boxes. The device has 2 separate DMX interfaces which are controlled separately. 
Specifications: 
 
Power supply: 

 Power over Ethernet (PoE)  (via RJ-45 except REG variant) 
 Terminal:    12-32VDC 
 Power consumption:   <= 1.2W 

 
Mechanical data: 

 Assembly:    Ceiling installation / DIN rail adapter: 
Modular device housing 4 MW 
DIN rail EN 50022 – 35x7.5 

 Dimensions (W x H x D) in mm:    
Ceiling installation   without fastening lugs: 50x26x116 

with fastening lugs: 50x26x146 
 Modular device housing   70x90x63 
 
Interfaces (model-dependent): 

 KNX     via terminal (twisted pair) 
 Network    via RJ45 connection 
 Wireless network   via external SMA antenna (except REG variant) 
 EnOcean    via external SMA antenna (except REG variant) 
 2xDMX 512    terminal, conductor cross-section: 1.5mm² 
 Input feeler    terminal, conductor cross-section: 1.5mm² 
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2.1 VARIANTS 

Standalone device variant (item no. 12041) 
As a standalone device, the Gateway receives the DMX commands via the smartphone APP “DUO DMX 
APP”. The device is connected to the network via a LAN cable. 
 
WLAN standalone device variant (item no. 12041w) 
It is similar to the standalone variant. The DUODMX GATEWAY is connected with the network via WLAN 
instead of LAN. 
 
IP device variant (item no. 12011) 
As IP variant, the device receives its control commands via the “KNXnet/IP” protocol.  
The KNX telegrams are sent and received via the KNXnet/IP routing protocol. 
Therefore, the device must be connected with the network.  
 
IP WLAN device variant (item no. 12011w) 
It is similar to the IP variant. The DUODMX GATEWAY is connected with the network via WLAN instead of 
LAN. 
 
IP SR device variant (item no.: 12111) 
The IP SR variant does not only allow for the sending of DMX commands due to incoming KNXnet/IP 
telegrams (see IP variant above) but also sends KNXnet/IP telegrams due to incoming DMX commands.  
The KNX telegrams are sent and received via the KNXnet/IP routing protocol. 
Therefore, the device must be connected with the network. The master/slave function (send/receive) 
can be adjusted separately for each DMX interface.  
 
IP SR WLAN device variant (item no.: 12111w) 
It is similar to the IP SR variant. The DUODMX GATEWAY is connected with the network via WLAN instead 
of LAN. 
 
KNX device variant (item no.: 12021) 
As KNX twisted pair variant, the device is directly connected with the KNX bus.  
The KNX telegrams are sent and received via the KNX bus. 
In addition, KNX telegrams can also be received via network using the KNXnet/IP routing protocol. 
For operation, network connection is not required. 
 
KNX SR device variant (item no.: 12121) 
The KNX SR variant does not only allow for the sending of DMX commands due to incoming KNX/TP 
telegrams (see KNX variant above) but also sends KNX/TP telegrams due to incoming DMX commands. 
The master/slave function (send/receive) can be adjusted separately for each DMX interface.  
The KNX telegrams are sent and received via the KNX bus. 
In addition, KNX telegrams can also be received via network using the KNXnet/IP routing protocol. 
For operation, network connection is not required. 
 
EnOcean device variant (item no.: 12031) 
As EnOcean variant, the device receives the control signals via the EnOcean radio system. The device 
only requires power supply. Moreover, an external antenna must be connected to the device. The DMX-
Configurator software enables the connection with the EnOcean profiles. For operation, network 
connection is not required. 
 
KNX SR device variant REG (item no.: 12521) 
The "KNX SR REG" variant is largely identical to the KNX SR device variant (item no.: 12121). 
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3 ASSEMBLY 

3.1 CEILING INSTALLATION VARIANT 

The device can be used for ceiling installation but also for DIN rail assembly. For ceiling installation, the 
device is equipped with fastening lugs at two sides.  
For DIN rail assembly, an adapter can be provided as an option. The fastening lugs are designed so that 
they can be dismantled on demand. 
 

 
Figure 1: DUODMX GATEWAY with lugs 

 
DIN rail adapter 
The adapter is mounted to the housing with two screws included in the scope of supply. Make sure that 
the adapter is screwed to the housing through the two grooved holes only. These two holes are marked 
by the red circles on the picture. 
 

 
Figure 2: DIN rail adapter 

 
Note: Please use the two marked holes if you assemble the DIN rail adapter to the DUODMX 
GATEWAY. If you do not use the correct holes, the screw ends may touch the bottom side of the 
circuit board! 
 
Please be careful if you want to loosen a device mounted on the DIN rail from the rail. If you apply 
excessive force when removing the gateway, the screws of the adapter might be ripped out from the 
housing. 
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3.1.1 CONNECTION DIAGRAM 

The following figure is an overview of any available connection variants of the DUODMX GATEWAY. 
 

 
Figure 3: DUODMX GATEWAY – connection diagram 

 
 
Connection with the DMX bus 
The device has two independently operating DMX interfaces. Depending on the type of device, the 
interfaces can be configured as DMX master (sending) or as DMX slave (receiving) on demand. The 
device is connected via a 6-pin pluggable screw terminal, polarity is indicated on the housing. It is also 
possible to use just one DMX output. The connections are short-circuit-proof (for device type SR) and 
can be bypassed.  
 

NOTE:  

- DO NOT CONFUSE the pluggable screw terminals (power supply side and DMX connection 

side)! 

- Please take care of the correct polarity when installing the power supply!  

At the end of this document you will find a description of the assignment of DMX connectors and 

sockets. 
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3.2 MODULAR DEVICE HOUSING VARIANT 

The device is used for DIN rail mounting, according to DIN EN 60715, in a REG housing 4 units. 
Dimensions (width x height x depth): 70 x 90 x 63 mm 
 

 So that the power supply and the DMX bus cable can be connected conveniently, the screw-
type plug-in terminals (see connection diagram below) are removable. 

 
 At first, connect the cables of the power supply as well as the DMX bus cable to the screw 

terminals (see figure below). Please note the polarity! 
 

 Afterwards, the screw-type plug-in terminals can be reconnected to the DUODMX GATEWAY. 
 

 The device can now be snapped onto the DIN rail, according to DIN EN 60715. 
 

 
Figure 4: DUODMX GATEWAY REG 
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3.2.1 CONNECTION 
DIAGRAM 

The following figure is an overview of any available 

connection variants of the DUODMX GATEWAY REG 

variant. 

Connection with the DMX bus 
The device has two independently operating DMX 
interfaces. Depending on the type of device, the 
interfaces can be configured as DMX master (sending) 
or as DMX slave (receiving) on demand. The device is 
connected via two 3-pin pluggable screw terminal; 
polarity is indicated on the housing. It is also possible 
to use just one DMX output. The connections are short-
circuit-proof (for device type SR).  

 

Figure 5: DUODMX GATEWAY – connection diagram 

 

1. SD Memory Card Slot 

2. button 

3. LEDs 

4. KNX/TP connection  

5. potential-free pushbutton interface  

6. power supply 

7. Ethernet connector 

8. DMX interface 2 

9. DMX interface 1 

 

NOTE:  

- DO NOT CONFUSE the pluggable screw terminals (power supply side and DMX connection 

side)! 

- The polarity is indicated on the housing 

- Please take care of the correct polarity when installing the power supply! 

THE CONNECTIONS MUST NOT BE EXCHANGED!  
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4 INITIAL OPERATION 

As a ceiling installation or REG device, the gateway can be installed close to the DMX system. You 
require the following components for operation: 

 power supply (conventional or PoE) 
 network connection (not mandatory but advantageous for configuration) 
 DMX bus connection 
 connection to one of the control media (network, KNX or EnOcean) 
 DMX-Configurator software 

 
The device is configured with the DMX-Configurator software via the network or an SD card. For this 
purpose, the device variant is unimportant.  
 
IMPORTANT NOTICE: If you configure the device via the local network, the PC must be in the same 
IP address range as the DUODMX GATEWAY. 
If configuration via the network is not possible, the project data can also be transferred with an 
SD card. SD cards in NTFS format are not supported! 
In case that DUODMX cannot be found, you must deactivate all network interfaces except for the 
currently used network interface! 
Please take care of the correct polarity when installing the power supply! 
 
For this purpose, you need a commercial SD card (FAT format) and a card reader for your PC!  
 
 

4.1 DMX-CONFIGURATOR INSTALLATION 

First of all, you must install the DMX-Configurator software. The setup file for the installation of the 
software is on the enclosed CD or can be downloaded at www.bab-tec.de.  
 
Installation instructions: 
Double-click on the setup.exe file. The setup dialogue opens up: 
 

 
Figure 6: DMX-Configurator setup dialogue 

 
Click on Next to navigate through the menu. Confirm the licence agreement and select a place of 
installation on the hard disk. Finally select Finish so that the installation wizard will start installing the 
program.  
 
Now you will find the program at Start > Programs > BAB TECHNOLOGIE GmbH > DMX-Configurator. 
  

http://www.bab-tec.de/
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4.2 DMX-CONFIGURATOR UPDATE 

If you want to install a newer version of the DMX-Configurator, it is important that you correctly uninstall 
the previous version beforehand. To this end, you must go to Start > System control > Programs and 
Functions (Software in Windows XP) and uninstall the DMX-Configurator. Select the new setup file now 
and proceed as described above. 
 
 

4.3 FACTORY SETTINGS 

The DUODMX GATEWAY is supplied with the following factory settings: 
 

 IP address:     192.168.1.223 
 Subnet mask:     255.255.255.0 
 Device name:     MAC address of the device 
 Physical KNX address:    15.15.255 
 Multicast address KNXnet/IP (“routing”):224.0.23.12  

      (can be changed as of firmware version 2.2.0.0) 
 EIBPORT system ID:    0  

      (cannot be changed) 
 
In addition to the firmware, there is also a DMX-Configurator sample project in the installation registry 
of the DMX-Configurator software. If necessary, it can be used to overwrite the loaded project in the 
DUODMX GATEWAY. 
 
 

4.4 INITIAL COMMISSIONING 

As a first step, connect a conventional 12-32V power supply (DC) to the appropriate pluggable screw 
terminals or to a PoE network connection (Figure 3) and connect the DUODMX GATEWAY to the 
network. The green power LED is continuously on once the device has been started.  
The second step is the configuration of the network settings. 
 
For configuration, the PC must be in the same IP address range as the DUODMX GATEWAY. 
If it is not possible to change the network settings of the PC, you can alternatively transfer the 
network settings by means of an SD card.  
 

 Start the DMX-Configurator and switch to the menu screen Extensions – DUO-DMX GATEWAY. 
 

 
 

Figure 7: DMX-Configurator – extensions 
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 You are prompted to enter your device type. You have the following options (next figure): 

 

 
 

Figure 8: DMX-Configurator – type selection 

 
 

a) KNX/BMX is for the following device types:  
o Standalone (item no. 12041) 
o IP (item no. 12011) 
o KNX (item no. 12021) 

 
b) KNX/BMX master/slave is for the following device types: 

o IP SR (item no. 12111) 
o KNX SR (item no. 12121) 

 
c) EnOcean is for the following device type:  

o EnOcean (item no. 12031) 
 

d) WLAN is for the following device types: 
o WLAN standalone (item no. 12041w) 
o IP WLAN (item no. 10211w) 

 
e)  WLAN master/slave is for the following device type:  

o IP SR WLAN (item no. 12111w) 
 
Depending on your selection, various configuration windows are provided. For a detailed description, 
please read the chapter “Extensions”.  
 
Please note: If you configure the device via the local network, the PC must be in the same IP 
address range as the DUODMX GATEWAY. 
If configuration via the network is not possible, the project data can also be transmitted with an 
SD card. 
 

 The network settings of the device can be accessed as follows:  
For  

o KNX/IP, KNX/IP SR, select the LAN/KNX tab. 
o WLAN and WLAN SR, select the LAN/KNX tab. 
o EnOcean, select the LAN/EnOcean tab. 

 
The figure below shows the configuration for the KNX/BMX variant as an example. 
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Figure 9: DMX-Configurator – device search 

 
 
 

 Press the Search button (orange arrow) below the DMX-Gateways field. All DUODMX GATEWAYs 
in the network are displayed, irrespective of the IP address settings of the PC.  

 
 On the basis of the search result (the displayed IP address) you must now check whether it is 

necessary to adjust the IP address of the DUODMX GATEWAY or not. 
 
 

 If adjustment is necessary, make the required settings in the fields provided for this purpose (IP 
address, subnet, gateway).  

 
 Do not change the Multicast address unless this is required. 

 
 Then close the Extension window and save the project with File > 

Save. 
 
 
 
 

CONFIGURATION UPLOAD via the network 

 
 Mark the DUODMX GATEWAY to which you want to upload the 

configuration. 
 

 Press the Upload button to start the upload. The message Upload 
completed will show you that your upload has been successfully 
completed. 

(blue arrow)  Figure 10: Adjusting the network settings 
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SAVING THE CONFIGURATION via SD card: 
 

 Close and acknowledge the configuration with OK. 
 

 Save the project (File > Save or Save as) 
 

 Open the File menu again and save the project by means of 
the Export HEX File under a unique name in the desired 
folder.  

 
 Insert your SD card in your card reader and make sure that 

the SD card does not contain any data.  
 

 Then copy the generated HEX file onto the SD card and 
rename it to “config.par”.  

 
 Insert the SD card into the slot of the DUODMX GATEWAY 

during operation. The status LED of the device will go out for a 
short while for reading the data.  
As soon as the green status LED is on again, the configuration is loaded.  

 
 
Please note: Only SD cards with FAT file system format are supported! 
 
Third and last step of the network configuration: 

 Restart the device by pressing the power button.  
 

 Open the DMX-Configurator and check, as described in the steps above, whether the new IP 
address settings have been applied to the DUODMX GATEWAY. From now on, you can transfer 
any configuration changes directly via the network (see chapter “Transmission of configuration 
files”).  

 
 
Further information is provided in chapter 5.5.2.3. LAN/KNX 
  

Figure 11: Saving the project 
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4.5 IMPORTANT INFORMATION ON THE VERSION 

Important notice: Please check for the most current version for both modules (software and 
firmware). 
 
Reading the software version 
The version number of the DMX-Configurator can be read from the title bar of the window.  
 

 
Figure 12: DMX-Configurator version 

 
Reading the firmware version 
Use the Search function in the LAN/KNX tab, LAN/EnOcean tab or WLAN tab in the Extension menu to 
find out which firmware your device is using (see also chapter “Activation of the (DMX) preview”). The 
firmware version is displayed together with the IP address and the device name. 
 

 
Figure 13: Display of the firmware version 

 
If your device does not have the most current firmware version, you must make a firmware update (see 
chapter “Firmware update”). Once your DUODMX GATEWAY has been equipped with the firmware 
2.0.0.1 or higher, the configuration data can only be transmitted by the DMX-Configurator 1.6.0.0 or 
higher.  
 
Older project data 
Projects from older software versions can be opened with the current DMX-Configurator without any 
problems. If you have commissioned your DUODMX GATEWAY with an older DMX-Configurator version, 
this version must be reloaded to the DUODMX GATEWAY once more using the current DMX-
Configurator (1.6.0.0 or higher).  
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4.6 DEVICE BEHAVIOUR IN CASE OF POWER 
FAILURE AND SWITCHING ON THE POWER 
SUPPLY AGAIN 

Device behaviour in case of power supply failure 
The behaviour of the DMX end devices in case of power supply failure at the DUODMX GATEWAY 
depends on the end devices. According to the DMX specification, components will switch to a save 
operating status (e.g. lamp off).  
 
 
Behaviour when the power supply is switched on again 
Once the supply voltage has been restored, all 512 DMX channels on both DMX interfaces are set to 
"0" by default.  
In the scene configuration it is also possible to trigger a selected “Start scene” after switching on the 
power supply of the DUODMX GATEWAY. 
In this way, it is possible to determine whether the lighting should be switched on or a scene should be 
start without further action.  
The configuration is carried out in the corresponding  
field "Default scene on start", select in this field the  
desired scene. 
 
 

 
Figure 14 Choose Default Scene on Start 

 
 
Behaviour in case of bus voltage failure (only KNX/TP device) 
If the bus voltage fails but the power supply of the devices can be maintained, only the control of the 
DUODMX GATEWAY is interrupted. The DMX signal is still sent so that the current “image” of the DMX 
output is maintained. The restoration of the bus supply does not change anything for the DMX (unless 
there are new KNX telegrams). 
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5 PROGRAMMING 

The DUODMX GATEWAY is programmed via the DMX-Configurator. In the DMX-Configurator, scenes are 
created which connect group addresses or EnOcean profiles with the dimmer channels or the scenes. 
The configuration is transmitted to the device via the network or via the SD card.  
 
IMPORTANT NOTICE: In case that the DMX-Configurator cannot find the DUODMX, you must deactivate 
all network interfaces except for the currently used network interface! 
 

5.1 ACTIVATING THE (DMX) PREVIEW FUNCTION 

Together with the DUODMX GATEWAY, the DMX-Configurator software offers the so-called Preview 
function. In the preview, any changes made to the DMX channel controllers are directly visible on the 
DMX device. Thus it is possible to directly test and change the sequences and scenes, if necessary, 
without having to transmit the configuration beforehand.  
 
Note: Please note that the DMX preview permanently sends values until the DMX-Configurator is closed 
and the preview is activated. If you tried to control the DMX channels via the corresponding bus system 
during the transmission of values, the commands of the bus system would be overwritten by the 
activated preview. So make sure to use either the preview or the appropriate control system (KNX/TP, 
KNXnet/IP, EnOcean).  
 
There are two preview variants: 
 

1. Broadcast preview: All DUODMX devices within the network are addressed by the preview, 
irrespective of the network settings and whether they comply with those of the PC on which 
the DMX-Configurator has been started. The preview signals are transmitted to the network by 
broadcast.  
 

2. Unicast preview: Only the selected DUODMX GATEWAY receives the preview signals. In this 
context it is important to make sure that the desired gateway and the PC are within the same 
network range. The signals are transmitted to a certain IP address by unicast.  

 
You can also determine for which of both DMX outputs the preview signals are provided. Got to 
Extension > DUODMX GATEWAY to activate the preview.  
 
The DMX-Out 1 and DMX-Out 2 preview functions stand for the DUODMX GATEWAY interfaces 1 and 2. 
 
Activating the broadcast preview 
In order to activate the broadcast preview, you just have to select one of the two check boxes DMX-
Out1 or DMX-Out2 (or both) and acknowledge your selection with OK. From now on, the preview 
signals are sent to the network via broadcast and are being run by all available gateways (figure at the 
top of the next page. Orange arrow). 
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Figure 15: Broadcast preview 

 
Activating the unicast preview 
In order to direct the preview to a specific device, you must select this device on the DMX Gateways list. 
To this end, you must click on the Search button. All devices within the network are displayed with IP 
address (default setting is the MAC address) and device name. To activate the preview for only one of 
the devices on the list, the desired device must be marked (blue background) and then the preview 
must be ticked to activate it.  
 

 
Figure 16: Unicast preview 

 
Note: The preview is not a setting which must be transmitted to the gateway or saved in the 
project data of the DMX-Configurator. It only has to be activated in the corresponding DMX-
Configurator and remains activated until the next software start.  
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5.2 SOFT ON / SOFT OFF 

If the DMX channels are switched on and off via the 1Bit object, the dimming value 100% and 0% is set 

directly, i.e. "jumped" directly without intermediate steps.  

With the option "Soft On/Off" a dimming function is activated for the first 128 DMX channels and 

switching on and off is carried out with intermediate steps and thus slower, softer.  

The activated function "Soft On/Off" causes the DMX channels to be switched on (0% - 100%) and off 

(100% - 0%) with a total dimming time of 5.2 seconds.  

The dimming time will be correspondingly shorter if it is not switched on at 0% or switched off at 100%. 

(Example. If the current dimming value is switched off at 50%, the dimming process is already 

completed after 2.6 seconds).  

The function is activated and deactivated together for both DMX interfaces in the extension menu 

(orange arrow). After uploading the project data, the function is active and the DMX channels 1 - 128 

switch on and off via the 1-bit object with a dimming time of 5.2 seconds. 

NOTE: The function only interacts with the 1-bit object. If a DMX channel receives a dimming value 

during a dimming process, e.g. via the 1 byte object, the dimming process is interrupted immediately.  

 

Figure 17: Soft ON / Soft OFF 

 

 

5.3 FIREWALL SETTINGS 

If a firewall is installed on the client computer, the ports 4042, 4044 and 4045 must be “enabled” for 
the DMX-Configurator. 
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5.4 DMX-CONFIGURATOR 

The DMX-Configurator control software is used for the creation of light images (steps) and light scenes 
(scene). The resulting configuration data are transmitted to the device via the network or the SD card. 
Moreover, the preview function shows the changes made at the DMX controllers in the DMX-
Configurator directly on the DMX end devices. The software is suited for any common Windows systems. 
It is provided on the supplied CD or at www.bab-tec.de (Service > Downloads).  
 
 

5.4.1 USER INTERFACE 

The user interface is clearly divided into 5 areas. 
 

1. Administration of scenes 
2. Scene settings 
3. Administration of steps 
4. DMX channel settings 
5. Menu bar for settings 

 

 
Figure 18: DMX-Configurator – user interface 

 
 
 
Different functions for the configuration of the software and hardware can be accessed via the menu 
bar. These functions are separately specified below. 
  

5 2 

4 1 

3 

http://www.bab-tec.de/


 
Programming DUODMX GATEWAY 

 

24 BAB TECHNOLOGIE GmbH DUODMX GATEWAY 

 

5.4.2 CHANGING THE LANGUAGE 

In order to change the menu language of the DMX-Configurator, you must open the “?” (Question 
mark) Menu; after having changed the language, the DMX-Configurator must be restarted. 

 

 
 

 
Figure 19: Changing the language 

 
 
 

5.4.3 GENERAL DATA STRUCTURE 

The light images are entered in two different steps. The first step is to create a scene which forms a 
group for the individual steps of the light sequence. 
 

 
 
A scene may include one or more steps, whereas static light images are created with one step and 
dynamic light images with several steps. 
 
  

PROJEKT

SZENE 1

SCENE 2

STEP 1

STEP 2

STEP 3

STEP 1



DUODMX GATEWAY  
 

 

DUODMX GATEWAY BAB TECHNOLOGIE GmbH 25 

 

5.4.4 CREATING SCENES 

Before you enter the individual steps, you must select or create a scene.  
 
A new scene is created with the NEW button (orange arrow). A New scene entry appears in the scene 
list (purple arrow). This name is freely editable. The first 15 characters are displayed on the APP. 
 
The Copy button (green arrow) copies the selected scene with all of its steps. 
 
The Delete button (blue arrow) deletes the selected scene with all of its steps. 
 

The arrow buttons  (red arrow) are used for changing the order of the scenes. 
 

 

 
 
 
Note: At the beginning of each scene, the DMX-Configurator assumes that the corresponding DMX 
channel values have the value “0”. Therefore, it might be that a scene adds or does not change your 
DMX values to already existing values. As a consequence, the DMX end device displays incorrect values 
(colours).  
 
This can be avoided if you start each scene with a step with the value “1” followed by a step with the 
value “0” (for the DMX channels which are not used). There is no fade between the steps and a 
minimum wait time of 10ms. In this way, each DMX channel is set to the desired value “0” before the 
actual scene begins. Depending on the requirements, we recommend that a special scene is created 
which is used for the “zeroing” of the desired DMX channels. 

  

Figure 20: Scene list 
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5.4.5 CREATING STEPS 

Steps must be created and edited in order to create individual light images and to connect them with 
each other so that a dynamic light image is formed. Static light images are also possible. 
 
 

 
Figure 21: Creating steps 

 
 
 
Channel controllers are provided for the setting of different DMX values. They are marked with the 
channel number. To reach all 512 DMX channels, you must select the DMX channel range using the 
horizontal slider below. 
You can allocate DMX channel numbers to the additionally provided channel quick-access buttons at 
the Program settings menu item which can then be accessed with a click. 
 
For each step, different DMX values can be set for each channel. Dynamic light images can be created 
by a sequence of several steps with different DMX values. The List of steps includes all steps in their 
corresponding order. The transition between two steps is defined by the fade time and the wait time 
which can be adjusted separately for each step. With the option Change all steps, the changes to the 
fade time and the wait time are applied to all created steps.  
 
Moving to the right/left  
All present DMX values are shifted by one channel to the right (+1) or to the left (-1). This allows for the 
simple setting of “running light” scenes.  
 

  

Step list 

Channel 
controller 

Channel quick-access buttons Moving to the left Moving to the right 

Fading and waiting time Repetition of scenes 

DMX value 
Direct input 

DMX master 
controller 
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5.4.6 COLOUR PICKER 

The colour picker allows for the easy input of RGB colour values. The three consecutive DMX channels 
(R/G/B values) are allocated to the selected colour. You can access the colour picker by right-clicking 
on the first RGB-DMX channel.  
 

 
Figure 22: Colour picker selection 

 
 
A menu opens up where you must left-click on the colour picker (orange arrow).  
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The dialogue of the colour picker is available in 2 different illustrations. On the left, there is the default 
illustration (normal style), and on the right, you see the colours in a colour circle (round style). 
 
Select the colours as follows: 

 Select the colour on the colour illustration. 
 Select the brightness of the colour. 
 Click on OK to apply the settings for R/G/B. 

 
 
 

   
Figure 23: Colour picker – two screens 

 
 
 
Note: Right-click on the controller for colour brightness to set it in the centre for 50% brightness. 

  

Brightness of the colour 

Colour 
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5.4.7 DMX GROUPS  

DMX groups are suited for the simultaneous editing of several channels. There are 16 groups where you 
can combine any channels to form a group. 
 
To create or edit groups, select Settings > Program settings in the menu and go to the Groups tab. 
 

 
Figure 24: Defining DMX groups 

 
Enter the DMX channels forming a group in the input field next to the group name. The DMX channels 
must be separated by a semicolon (;). It is possible that one DMX channel is allocated to different 
groups. 
 
After having defined the groups, they are available in the group selection. If you select a group, the 
selected channels are marked by the control boxes and enabled. They are connected with each other, 
and all channels are set to the same value once you change one of the controllers. 
Any additional channels which are not defined in a group can be manually selected by the control boxes 
and temporarily added.  
 

 
 

  Display of the channels 
arranged in groups 

Group selection 
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5.4.8 DMX MASTER GROUP 

The master group is a specific group. The DMX channels included in the master group are scaled 
according to the master value when being output on the connected interface. 
 
Example 1:  DMX value = 100%;  Master = 50%   equals 50% in the output 
 
Example 2:  DMX value = 50%;  Master = 50%   equals 25% in the output 
 
 
 
 

 

 
 
NOTE: This element is only effective for the reproduction (preview) of scenes with enabled 
preview function! 
 
 

5.4.9 BEHAVIOUR OF SCENES  

Scene settings: The actions which are being run after the last step of a scene are defined in the selection 
field of the scene settings (orange arrow). 

 Repeating scenes: The scene is being run in repeat mode. 
 Stopping scenes: After the last step, the execution is stopped. The light image of the last step 

is maintained. 
  

DMX master controller 

Figure 25: DMX master controller 
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5.4.10 SAVING AND LOADING PROJECTS 

In the File menu item, you can save your created scenes and steps as a Project and open them again. 
The created files are saved in the specific *.dx1 format; besides the scenes and steps, they also include 
the channel settings.  
 

 

 
 

5.4.11 EXPORTING AND IMPORTING SCENES 

Moreover, you can separately save individual scenes. This is useful if you need the same scene in another 
project. Use the menu item Scene > Export to save individual scenes. The saved file has the extension 
*.scn. Use the menu item Scene > Import to add an exported scene to your project. 
 

 

 
 

5.4.12 EXPORTING AND IMPORTING STEPS 

Steps can also be saved separately. To this end, proceed analogously to the scenes. Use the menu item 
Step > Export to save individual steps. The saved file has the extension *.stp. Use the menu item Step > 
Import to add an exported step to the end of the step list. 
 

 

  

Figure 26: Loading and saving projects 

Figure 27: Scene export and import 

Figure 28: Export and import of steps 
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5.4.13 DEVICE MANAGEMENT 

To combine the individual DMX channels in one device, you must allocate the channels to this device. 
Go to the device management for this purpose. The device management can be accessed via the menu 
item Settings > Device management.  
 

 
Figure 29: Device management 

 
In the left half of the window, the DMX channels are listed individually (address 1 – 512). Once you have 
marked a channel, you can assign a name and a special colour to this channel. To this end, you must 
access the input screen at the right side. RGB and RGBW devices are defined as follows: 
 
RGB device: 

 Mark the first channel of the desired DMX device (e.g. channel 1 “Ch1”). 
 Enter the desired name of your DMX device in the Name field of the right-hand configuration 

window (e.g. RGB lamp 1). 
 Now right-click on the channel and select Add RGB channels. The device management 

automatically adds the RGB channels.  
 
The RGB device is defined. It is named after the name you have assigned in the first channel.  
 
RGBW device: 

 As above, but select Add RGBW channels in the context menu.  
 
 
 
Note: The number of names that can be assigned in the device management is limited!  
A maximum of 225 names (each with a maximum of 15 characters per name) can be created. 
The default of 15 characters per name is explained by the fact that only 15 characters per DMX 
channel can be displayed in the app. Names with more than 15 characters reduce the maximum 
number of names and are not displayed in the app. 
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5.4.14 APPLICATION SETTINGS 

The settings for the main program are under the menu item Settings > Application settings. 
 

 

 
The settings are divided into several groups. 
 
If you directly load the file during the starting process, you define whether and which project is to be 
loaded during the start of the software. 

 None: No project is loaded. 

 Load special file: The indicated project is loaded. Select the project file with the field (blue 
arrow). 

 Load last file: The previously opened project is loaded. 
 
 

5.4.15 MEMORY LEVEL DISPLAY 

As of DMX-Configurator version 1.6.0.0, there is a memory level display (orange arrow). The DUODMX 
GATEWAY has a total memory capacity of 64 kbyte. The level display shows how much capacity of this 
memory is used up for your current configuration. If you transmit more information to a device, you will 
cause malfunctions. 
 
Note: Some of the memory is used up by the communication objects right after the creation of a 
project.  
 
  

Figure 30: Application settings – file 
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5.5 EXTENSIONS MENU 

The specific settings for the DUODMX GATEWAY are made in the Extensions menu at the DUODMX 
Gateway extension. Here, the device is connected with group addresses or EnOcean profiles, IP 
addresses are assigned and configuration data are transmitted. Moreover, it is possible to search for 
devices in the network, to activate the DMX preview and to switch between master and slave operation.  
 
 

5.5.1 SELECTING THE DEVICE VARIANT 

Before making the specific settings of the DUODMX GATEWAY, the device variant must be selected. 
When selecting the Extensions menu for the first time, the following options appear: 
 

 
Figure 31: Selecting the device variant 

 
Select the corresponding bus type for your device variant. Overview of bus types / device variants: 
(The marking on the front side shows which device variant you have.) 
 
KNX/BMX is for the following device types:  

DUODMX GATEWAY Standalone (item no. 12041) 
DUODMX GATEWAY IP (item no. 12011) 
DUODMX GATEWAY KNX (item no. 12021) 

 
KNX/BMX SR is for the following device types: 

DUODMX GATEWAY IP SR (item no. 12111) 
DUODMX GATEWAY KNX SR (item no. 12121) 

 
EnOcean is for the following device type:  

DUODMX GATEWAY EnOcean (item no. 12031). 
 
WLAN is for the following device types: 

DUODMX GATEWAY Standalone WLAN (item no. 12041w) 
DUODMX GATEWAY IP WLAN (item no. 10211w) 

 
WLAN SR is for the following device types:  

DUODMX GATEWAY IP SR WLAN (item no. 12111w) 
 
 
Once you have selected the device type, the configuration window for the corresponding technology / 
bus type opens up. This selection is displayed once after the first access of the DUO-DMX Gateway 
extension.  
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5.5.2 KNX/IP CONFIGURATION 

If the DUODMX GATEWAY is a KNX or IP device, the KNX/BMX bus type must be selected for the device 
selection.  
 

 

 
Figure 32: Device selection – KNX/BMX 

 
This applies to the following device types: 
 

 DUODMX GATEWAY IP 
Controlled via the KNXnet/IP protocol (based on the network)  

 DUODMX GATEWAY KNX 
Controlled via the KNX twisted pair bus (two-wire bus).  

 
In any case, the device is controlled via KNX group addresses but the transmission channel of the 
telegrams is different.  
 
After having selected this bus type, the Extension window with KNX-specific parameters opens up. The 
window is divided into two parts: The left part of the window contains the group address administration 
and the right part of the window contains the connections with DMX and the LAN/KNX configuration.  
 

 
Figure 33: KNX/BMX configuration 
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5.5.2.1 GROUP ADDRESS ADMINISTRATION 

The DMX channels and the created scenes of both DMX interfaces must be connected with group 
addresses. Otherwise, they cannot be controlled by the devices IP, KNX, IP SR and KNX SR. This is not 
necessary for the control via the DUO DMX APP. First of all, addresses must be provided in the group 
address administration. You have the following two options to this end:  

1. Either creating group addresses in the DMX-Configurator, or  
2. Using the ESF data import.  

 

 

 

 

CREATING GROUP ADDRESSES IN THE DMX-CONFIGURATOR 

If there is no suitable ESF file with appropriate group addresses, the required group addresses can be 
created right in the DMX-Configurator. To do this, please proceed as described below: 
 

1. Creating main and middle group 
Right-click in the empty group address field after having marked “Group addresses”; you are 
prompted to create a new main group and assign a name. Then right-click on the main group 
and create a middle group.  

 
2. Creating a group address 

Create the desired group address by right-clicking on the middle group. A window pops up 
where you can enter the Number, Name and Object type.  

 

Figure 34: Group address administration 
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Figure 35: Creating group addresses 

 

Object types: 
 1 bit: DPT 1.001 (EIS 1 Switch), value: [0.1] 
 4 bit: DPT 3.007 (EIS 2 Dimming relative), value: [lighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 
 3 byte DPT 232.600 RGB, value [R 0 – 255, G 0 – 255, B 0 – 255] 
 4 byte DPT 12.001 4 byte unsigned as RGBW, value [(0…4 294 967 295): 1st byte = R, 

2nd byte = G, 3rd byte = B, 4th byte = W] 
 

3. Deleting entries: 
To delete your entry, you must mark it and press the delete button (Del) on your keyboard. 

 
 

USING THE ESF DATA IMPORT 

To connect the group addresses of an ESF file (group address file with the extension *.esf), it must be 
exported directly from the ETS (or from the EIBPORT) beforehand. The following data types are relevant 
for all objects of the DUODMX GATEWAY: 
 

 1 bit: DPT 1.001 (EIS 1 Switch), value: [0.1] 
 4 bit: DPT 3.007 (EIS 2 Dimming relative), value: [lighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 
 3 byte DPT 232.600 RGB, value [R 0 – 255, G 0 – 255, B 0 – 255] 
 4 byte DPT 12.001 4 byte unsigned as RGBW, value [(0…4 294 967 295): 1st byte = R, 

2nd byte = G, 3rd byte = B, 4th byte = W] 
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To import an ESF file to the DMX-Configurator, proceed as follows: 
 

1. Importing an ESF (group address) file 
Open the menu Extensions > KNX > Import ESF in the DMX-Configurator.  

 
 

 
Figure 36: Importing an ESF file 

 
After having selected the desired ESF file, the address tree is displayed in the left window. Press 
“+” (plus) and “-” (minus) to expand or reduce the tree. 
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5.5.2.2 GROUP ADDRESS CONNECTION 

Once the group addresses are available (see below). They can be used to connect the different DMX 
channels of the DMX interfaces. The created scenes are provided in the Scene out tab, the DMX 
channels are provided in the Dimmer out tab and the defined DMX lamps are provided in the Device 
tab.  
 
 

CONNECTING THE SCENES (SCENE OUT) 

All scenes created in the DMX-Configurator are listed in the Scene out 1 and Scene out 2 tabs. The 
scenes can be connected with the following data types:  
 

 1 bit: DPT 1.001 (EIS 1 Switch), value: [0.1] 
 
Scenes are started by telegrams with the value “1” and stopped or interrupted by the telegram value 
“0” (see chapter “LAN/KNX”).  
 
To create a connection, please proceed as described below: 
 

 Simply drag the desired group address from the address tree at the left side to the 
corresponding scene at the right side. Then the group address is illustrated below the scene. 
(see figure below) 

 
 

 
Figure 37: Connecting the group addresses with the scenes 

 
Each scene can be started with any number of group addresses. All relevant addresses are dragged to 
the scene. 
 
Note: The program automatically checks for the connection whether the selected group address 
has the correct data type for the communication object. If this is not the case, the connection is 
not possible and the group address cannot be connected.  
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CONNECTING THE DMX CHANNELS (DIMMER OUT) 

Not only the scenes but also the DMX channels can be controlled individually. In this context, each of 
the 512 DMX channels represents its own KNX actuator channel with the data point types 1-bit switch, 
4-bit relative dimming and 1-byte absolute dimming. 

 1 bit: DPT 1.001 (EIS 1 Switch), value: [0.1] 
 4 bit: DPT 3.007 (EIS 2 Dimming relative), value: [lighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 

 
The DMX channels can be connected with several KNX group addresses. In this context, the first group 
address is sending and receiving, while all other addresses are only receiving. (Sending and listening 
group addresses)  
 
To create a connection, please proceed as described below: 

 Simply drag the desired group address from the address tree at the left side to the 
corresponding communication object at the right side. Then the group address is illustrated 
below the object. (see figure below) 

 

 
Figure 38: Connection of the dimmer channels 

 
If a DMX channel is switched on via 1 bit, the 1-byte communication object adopts the previously set 
value. For example, if the 1-byte communication object was dimmed to 50% and then switched off, it 
starts at 50% when being switched on again. (Memory function) 
 
STATUS FEEDBACK SIGNAL AND SCENES.  

The DUODMX GATEWAY behaves similarly to the KNX dimmer. 
This means that if a DMX channel is switched on or off via a 1-bit or 4-bit KNX telegram, the DUODMX 
GATEWAY sends a 1-byte KNX telegram with the current value as status feedback signal.  
And vice versa, if a DMX channel is switched on or off via a 1 byte KNX telegram, the DUODMX 
GATEWAY sends a 1 bit KNX telegram with the current status (ON/OFF) as status feedback signal. 
This is the reason why the DUODMX GATEWAY does not require a separate feedback signal address. 
 
As of firmware version 2.2.0.4, the status of the DUODMX GATEWAY is also sent if an ongoing scene has 
been stopped. Thus, visualisation elements are updated to the correct condition of the DMX devices 
with this status feedback signal.   
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Note: The program automatically checks for the connection whether the selected group address 
has the correct data type for the communication object. If this is not the case, the connection is 
not possible and the group address cannot be connected.  
 

DMX channel value distribution 
If the value of a DMX channel falls below a value of 10% (25), a “0” is sent on the 1-bit KNX object. If 
the value, however, exceeds the 10%, a “1” is sent on the 1-bit KNX object. 
 
 

CONNECTION WITH PRE-DEFINED DEVICES 

Besides the dimmer channels and the scenes, the group addresses can also be connected with DMX 
devices previously defined in the DMX-Configurator. In this context, a DMX device can either consist of 3 
(RGB lamp) or 4 (RGBW lamp) DMX channels. To control these devices directly by a group address, the 
following data types must be used:  
 

 3 byte DPT 232.600 RGB, value [red 0 – 255, green 0 – 255, blue 0 – 255] 
 4 byte DPT 12.001 4 byte unsigned as RGBW, value [(0…4 294 967 295):  

1st byte = red, 2nd byte = green, 3rd byte = blue, 4th byte = white] 
 
To combine the individual DMX channels in devices, please proceed as described in the chapter “Device 
management”. Once the devices have been defined there, they appear automatically in the window 
Device 1 (for DMX out 1) and Device 2 (for DMX out 2). To create a connection, please proceed as 
described below: 
 

 Simply drag the desired group address from the address tree at the left side to the 
corresponding device at the right side. Then the group address is illustrated below the object. 
(see also figure below) 

 
Note: The program automatically checks for the connection whether the selected group address 
has the correct data type for the communication object. If this is not the case, the connection is 
not possible and the group address cannot be connected.  

 

 
Figure 39: Connection with pre-defined devices 
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5.5.2.3 LAN/KNX 

The settings specific for the network and for KNX are made in the LAN/KNX tab.  
 
IMPORTANT NOTICE: In case that DUO DMX cannot be found, you must deactivate all network 
interfaces except for the currently used network interface! 
 
 

 
Figure 40: KNX DUODMX GATEWAY 

 
 

1. Activating/deactivating DHCP  
2. IP address setting and KNXnet/IP (routing) multicast group.  
3. List of the DUODMX GATEWAYs available in the network. Is reloaded by pressing the Search 

button. The corresponding gateway is indicated together with its IP address, the assigned name 
and the current firmware version number (as of firmware 2.0.0.1). If the device has not yet been 
assigned a name, its MAC address is indicated. With a mouse click, you can mark a device for the 
configuration data upload or the activation of the unicast preview.  

4. Press the Search button to show all DUODMX GATEWAYS available in the network. Once the 
desired device has been marked in the list and the Upload button has been pressed, all current 
configuration data are transmitted to the device via the network (PC and DUODMX GATEWAY 
must be in the same IP address range).  

5. You can specify at this point, for which of the both DMX interfaces you want to enable the 
preview. The preview is not enabled until you have ticked the check box (broadcast preview). If a 
device is also marked in the DMX Gateways list, the preview is only applicable to this device 
(unicast preview). In this case, the PC and the gateway must be in the same network range 
(subnet). (See also chapter “Enabling the DMX preview”).  
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6. Determines the behaviour of a started scene when a telegram with the value “0” is sent to its 

connected group address. In case of Pause, the ongoing scene is stopped and continues at this 
point once it has been triggered again. In case of Stop, the scene starts from the beginning once 
it has been triggered again.  

7. Assign a physical address to the KNX variants of the device.  
8. Here you can assign a unique name to each device. This name will appear in the DMX gateways 

list instead of the MAC address.  
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5.5.3 IP SR CONFIGURATION 

If the DUODMX GATEWAY is a KNX or IP device with integrated master/slave SR function (send/receive), 
the KNX/IP master/slave must be selected as bus type for the device selection.  
 

 
Figure 41: KNX/IP master/slave device selection 

 
This applies to the following device types: 
 

 12111 DUODMX GATEWAY IP SR 
Communication (sending/receiving) via the KNXnet/IP protocol (based on the network). 

 
 12121 DUODMX GATEWAY KNX SR 

Communication (sending/receiving) via the KNX twisted pair (two-wire bus).  
 
In any case, the device communicates via KNX group addresses but the transmission channel of the KNX 
telegrams is different. The configuration window of these device types is only slightly different to that of 
the IP configuration. 
 
 

5.5.3.1 SPECIAL FEATURES OF THE MASTER/SLAVE (SR) FUNCTION 

The device variants with the ending SR offer the option of using one or both DMX interfaces not only as 
DMX master (sending) but also as DMX slave (receiving). For this purpose, there are check boxes in the 
LAN/KNX tab (only after having selected the correct device variant, see above) where you can set the 
operating mode of the DMX interfaces separately.  
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Figure 42: Configuration for DMX slave 

 
By activating the check box, the corresponding DMX interface is switched to slave mode. A DMX master 
(DMX light control panel), for example, can be connected to this DMX interface. 
Thus, commands are received from the DMX via the SLAVE DMX interface and forwarded to KNX. 
 
See the following example. The configuration shows how a KNX actuator is controlled via a DMX mixing 
desk. 
The DMX mixing desk is connected to the DMX interface 2 (see red rectangle; Out 2 is selected as the 
slave (red arrow)). 
In the Dimmer Out 2 tab, the KNX group address 1/1/1 (EIS6, 1 byte) is assigned to the DMX channel 1 
(orange arrow).  
Thus, the received dimming value from the DMX channel 1 (0%-100%) is directly forwarded to the KNX 
group address 1/1/1. 
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(EXCEPTION) FEEDBACK SIGNAL OF ANY INFORMATION FROM THE DMX WORLD 

 
PLEASE NOTE: THIS IS ONLY NECESSARY, IF ANY STATUS IS TO BE ACTIVELY SENT FROM DMX TO KNX 
(VERY HIGH TELEGRAM LOAD!)! 
BY DEFAULT, THE DUODMX GATEWAY SENDS STATUS FEEDBACK SIGNALS TO KNX WITHOUT THIS 
KIND OF FEEDBACK SIGNAL! 
 
To allow for sending and receiving on a DMX line at the same time, it is possible to establish a link 
between interfaces. ONLY IF, for example; DMX Out 1 is defined as master and DMX Out 2 is defined as 
slave, YOU MAY connect both DMX interfaces directly with each other at the terminal. 
 
To receive the DMX channel values as KNX telegram in slave mode, the corresponding output of the 
DMX interface in slave mode must be provided with an appropriate (feedback signal) group address. In 
this context, only the following communication objects of the dimmer channels are relevant (Dimmer 
Out 1 and Dimmer Out 2): 

 1 bit: DPT 1.001 (EIS 1 Switch), value: [0.1] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 

 
If the DMX interface 2 is configured as slave, as in the example above (orange arrow), both 
communication objects of the corresponding DMX channel can be connected in Dimmer Out 2 with the 
addresses for the status feedback signal.  
 

 
Figure 43: Connection with addresses for status feedback signal 

 
 
Note: If you configure one DMX interface as DMX master and one DMX interface as DMX slave, 
please make sure not only to send on the group address of the configured DMX slave interface on 
KNX (the actual value coming from DMX) but also the feedback signal on the group address(es) of 
the DMX master (the current value of the communication object).  
  

“Dimmer Out 2” 
configured as SLAVE 
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For a better understanding, the previous figure shows the assigned KNX group addresses for the control 

of the DMX channels in Dimmer Out 1. 

  

“Dimmer Out 1” 
configured as MASTER 



 
Programming DUODMX GATEWAY 

 

48 BAB TECHNOLOGIE GmbH DUODMX GATEWAY 

 

5.5.3.2 GROUP ADDRESS ADMINISTRATION 

See chapter “Configuration for KNX/IP”. 
 
 
Creating group addresses in the DMX-Configurator 

See chapter “Configuration for KNX/IP”. 
 
 
Using the ESF data import 

See chapter “Configuration for KNX/IP”. 
 
 

5.5.3.3 GROUP ADDRESS CONNECTION 

See chapter “Configuration for KNX/IP”. 
 
 
Connecting the scenes (Scene out) 

See chapter “Configuration for KNX/IP”. 
 
 
Connecting the DMX channels (dimmer out) 

See chapter “Configuration for KNX/IP”. 
 
 
Connection with pre-defined devices 

See chapter “Configuration for KNX/IP”. 
 
 

5.5.3.4 LAN/KNX 

See chapter “Configuration for KNX/IP”. In this case, the configuration only differs in the additional 
parameters for DMX master / slave (see above). 
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5.5.4 ENOCEAN CONFIGURATION 

If the DUODMX GATEWAY to be configured is a device with integrated EnOcean transceiver, you must 
select the EnOcean variant for device selection. The selection applies to the following device types: 
 

 12031 DUODMX GATEWAY EnOcean 
The device is controlled by EnOcean radio profiles.  

 

 
Figure 44: EnOcean device selection 

 
 

5.5.4.1 CONNECTION OF ENOCEAN PROFILES 

The left half of the Transmitter column shows all EnOcean profiles received by the DUODMX GATEWAY 
EnOcean. The profiles are displayed with their EnOcean-specific names. If you click twice on the profile 
name (no double-click!), you can rename it. To ensure better allocation at a later point in time, assign a 
unique name for EACH profile such as Switch_Rocker1_ON. 
 

 
Figure 45: EnOcean configuration – naming profiles 
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In this context, the DUODMX GATEWAY of the EnOcean variant supports the EnOcean profiles ORG0x5 
(for supported EnOcean profiles see chapter "Supported EnOcean profiles"). These profiles correspond, 
e.g. to tactile sensors or window handles. To delete a received profile from the list, you must mark it 
and delete it with the Del button. Once the profiles have been named as described above and light 
scenes have been created by means of the DMX-Configurator (see chapter “Creating scenes”), the 
profiles are simply assigned to the desired channels or scenes by drag & drop.  
 

 
Figure 46: EnOcean – connection of scenes 

 

CONNECTION OF SCENES 

In case of EnOcean, the scenes are started and stopped with the same profile. This means that a rocker 
switch can start and stop or interrupt two different scenes. The behaviour of the scenes for an OFF or 
STOP telegram can be defined in the LAN/EnOcean tab.  
 
It is also possible to connect several profiles with one scene. To delete a connection, you simply must 
mark it and then press the Del button.  
 
 

CONNECTION OF THE DMX CHANNELS 

To allow for the direct dimming of the DMX channels in the DMX outputs with EnOcean profiles, it is 
necessary to connect both profiles of a rocker switch for each channel.  
 

 
Figure 47: EnOcean – connection of the DMX channels 
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The DUODMX GATEWAY identifies the dimming as soon as one of the buttons is pressed for more than 
500ms, and it stops it, as soon as the button is released. Press the ON button of the rocker switch for 
brighter dimming and the OFF button for darker dimming.  
 

ENOCEAN CONFIGURATION EXAMPLE 

Below are the individual steps for controlling (switching and dimming) a DMX channel (e.g. the white 
channel of an RGBW lamp) with an EnOcean button (by means of a rocker switch): 

1. Start the DMX-Configurator.  
2. Open the Extension menu and select the EnOcean variant.  
3. Press and release the EnOcean button at the ON side. This received EnOcean profile is 

immediately displayed on the left side of the window. (NOTE: the simple EnOcean button sends a 
unique EnOcean profile for both sides of the rocker switch!). See the following figure. 

 

 
 

4. To avoid confusion, rename the profile e.g. to Switch ON. 
5. Repeat the steps 3 and 4 for the OFF status of the rocker switch of the EnOcean button. Rename 

this profile accordingly e.g. to Switch OFF. 
 

 
 

6. Before loading the configuration to the DUODMX GATEWAY, the received EnOcean profiles must 
be allocated to the desired DMX channel. Both profiles (ON and OFF) are allocated to the same 
DMX channel. Both profiles are necessary for switching on and off, or for dimming. 
The figure above shows the complete configuration which is necessary for switching on and off or 
for dimming the fourth DMX channel via an EnOcean tactile sensor.  
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5.5.4.2 LAN/ENOCEAN 

Please use the chapter “LAN/KNX” (see above) for the description of the network settings, search 
function, behaviour of scenes and device names. 
 
 

EXCEPTIONS FOR THE LAN/ENOCEAN CONFIGURATION 

One exception for the DUODMX GATEWAY EnOcean variant is that it also offers a Repeater function in 
addition to its Gateway function. In this context, the device repeats all received EnOcean signals thus 
increasing the signal range. There are two options 
 

 
Figure 48: EnOcean – repeater function 

 
1. Check boxes for the activation of the EnOcean repeater function. 

 
EnOcean repeater 
The device repeats all received EnOcean radio signals with low transmission power. Systems with several 
repeaters thus prevent signals from being repeated twice.  
 
Repeater level 2 
The device repeats the signals with full transmission power. This should only be used if you can ensure 
that the repeated signal does not reach a second repeater.  
 
 

In case that DUODMX cannot be found, you must deactivate all network interfaces except for the 
currently used network interface! 
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5.5.5 WLAN CONFIGURATION  

IMPORTANT NOTICE: The configuration must be transmitted via an SD card (see Transmitting via SD 

card on page 59). The LAN connector is without any function in this variant! 

If the DUODMX GATEWAY to be configured is a device with integrated wireless LAN module, the bus 
type WLAN or WLAN master/slave must be selected for the device selection. The selection applies to the 
following device types: 

 12041w DUODMX GATEWAY Standalone WLAN 
 12011w DUODMX GATEWAY IP WLAN 
 12111w DUODMX GATEWAY IP SR WLAN 

 
 

 
Figure 49: Device selection – WLAN 

 
To connect the DUODMX GATEWAY with the radio network, you must enter the SSID, the encryption 
type and the key. Exception: if there is no encryption for the WLAN. 
The name of the radio network is entered under SSID (blue arrow). The encryption type is selected in the 
WLAN field (green arrow). WAP and WEP are supported. The key for the encryption is entered in the Key 
field (red arrow). 
 

 
Figure 50: Radio network configuration 
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IMPORTANT NOTICE:  

The configuration must be entered via an SD card, since the WLAN variant of the DUODMX 

GATEWAY does not communicate via the cable network. The LAN connector is deactivated in this 

variant! 

The DUODMX GATEWAY LED shows whether the remote access to the WLAN network was successful.  

 GREEN LED flashes. The DUODMX GATEWAY accesses the WLAN network or tries to 

access it. 

 

 GREEN LED is on. The DUODMX GATEWAY has successfully accessed the WLAN network. 

 

 RED LED flashes. The WLAN MODULE of the DUODMX GATEWAY has not been initialised.  

 
In case that DUODMX cannot be found, you must deactivate all network interfaces except for the 
currently used network interface! 
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5.5.6 CHANGING THE IP ADDRESS CONFIGURATION 

To change the IP address settings of an already commissioned device, please proceed as follows: 
 
Please note: For configuration, the PC must be in the same IP address range as the DUODMX 
GATEWAY. 
If it is not possible to change the network settings of the PC, you can alternatively transfer the 
network settings by means of an SD card.  
 

 If you have selected KNX/BMX and KNX/BMX master/slave, switch to the LAN/KNX tab, if you 
have selected EnOcean, switch to the LAN/EnOcean tab, and if you have selected WLAN, switch 
to the WLAN tab. The figure below shows the configuration for the KNX/BMX as an example.  

 
 Press the Search button below the DMX-Gateways field. All DUODMX GATEWAYs in the network 

are displayed, irrespective of the IP address settings of the local PC.  
 

 
Figure 51: DMX-Configurator – LAN/KNX window 

 
Note: If the device is not on the list even if after having pressed the Search button, you probably 
have a problem with your network configuration (e.g. firewall / router settings), or you have 
activated two network cards at the same time. Please check. In case of doubt, please contact the 
BAB Technologie support! 
 

 Check the pre-set IP address of the Gateway in the DMX Gateways window.  
 

 To provide the DUODMX GATEWAY with a new configuration, you must adjust the IP address 

range of your PC so that it corresponds to the address range of the DUODMX GATEWAY.   
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Note: Configuration data can only be transmitted if the DUODMX GATEWAY and the PC are within 
the same network range (subnet)! 
 

To change the IP address of your PC, proceed as follows: 

 Open the network settings of your computer (example: Windows 7) and assign an IP address in 
the subnet of the DUODMX GATEWAY to your computer.  

 

 
Figure 52: Windows – network settings 

 
 Switch to the LAN/KNX, LAN/EnOcean or WLAN tab in the DMX-Configurator and change the IP 

address settings according to your requirements.  
 

 
Figure 53: DMX-Configurator – IP address settings 

 
 If you want, assign a name to your device. 

 
 Search again for the DUODMX GATEWAY and mark the desired device in the DMX Gateways list. 

Click on Upload to transmit the current settings from the DMX-Configurator to the DUODMX 
GATEWAY. The successful transmission will be acknowledged with the message “Upload 
successfully completed”. Otherwise, you will receive an error message. If this is the case, you 
must check the network settings of your PC and the DUODMX GATEWAY once more.  

 

 
Figure 54: DMX-Configurator – transmitting the configuration 
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 Then quit the LAN/KNX, LAN/EnOcean or WLAN window by pressing OK and save the current 
settings as project file *.dx1 in the menu File > Save as. Please use this project file for the further 
project setup.  

 

 
Figure 55: DMX-Configurator – saving the project 

 
Note: If you want to use a new or different project, please mind the IP address settings. With 
every new project, the default IP address settings are provided in the configuration. For an 
existing project, the DUODMX GATEWAY will adopt the IP address settings from the project.  
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5.5.7 TRANSMITTING THE CONFIGURATION DATA 

The configuration data can be transmitted via the network or via an SD card. The configuration data 
include:  

 All DMX-relevant data (scenes, channels, devices) 
 All connections 
 IP addresses and configuration data 

Exception: the settings for the DMX preview! 
 
 

5.5.7.1 TRANSMITTING VIA NETWORK 

To allow for the transmission of the data to the device via the network, the PC and the DUODMX 
GATEWAY must be within the same network range (subnet). If necessary, change the network settings of 
your PC (see chapter “Transmitting the network configuration”). 
 
To transmit configuration data via the network, you must proceed as follows: 

 If you have selected KNX/BMX and KNX/BMX master/slave, switch to the LAN/KNX tab, if you 
have selected EnOcean, switch to the LAN/EnOcean tab, and if you have selected WLAN, switch 
to the WLAN tab. The figure below shows the configuration for the KNX/BMX as an example.  

 Press the Search button below the DMX-Gateways field. All DUODMX GATEWAYs in the network 
are displayed, irrespective of the IP address settings of the PC.  

 

 
Figure 56: DMX-Configurator – LAN/KNX window 

 
Note: If the device is not on the list even if after having pressed the Search button, you probably 
have a problem with your network configuration (e.g. firewall / router settings), or you have 
activated two network cards at the same time. Please check. In case of doubt, please contact the 
BAB Technologie support! 
 
 

 Mark the desired device in the DMX Gateways list. Click on Upload to transmit the current 
settings from the DMX-Configurator to the DUODMX GATEWAY. The successful transmission will 
be acknowledged with the message “Upload successfully completed”. Otherwise, you will 
receive an error message. Then check the network settings of your PC and the DUODMX 
GATEWAY once more.  
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Figure 57: DMX-Configurator – transmitting the configuration 

 
Note: By uploading the current settings, the configuration data are uploaded to the device but 
not saved on your PC. If you close the DMX-Configurator without saving the project, all changes 
made will be lost. 
 
 

5.5.7.2 TRANSMITTING VIA SD CARD 

Besides saving the projects as DMX project files, they can also be exported as so-called HEX files. This file 
format is required to transmit the configuration data to the DUODMX GATEWAY via SD card. In this 
context, the configuration file must always have the same name (config.par) so that it can be identified 
and imported by the DUODMX GATEWAY. The green Power LED indicates the loading status (as long as 
the LED is off, the file is being imported). Configuration files are created as described below (after you 
have saved the project (as *.dx1 file)): 
 

 Open the menu File > Export HEX file.  
 Save the HEX file with a unique name in the desired folder.  
 Create a folder for the config.par file on your hard disk.  
 Then copy the generated HEX file into the folder and rename it to config.par. 
 Insert the SD card in the card reader and move the new config.par to the SD card. 
 Insert the SD card in the slot of the DUODMX GATEWAY and wait until the green LED is on.  

 
Ready.  
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6 DUO DMX APP 

The DUO DMX APP allows for the direct control of DMX components. With the DUO DMX APP, the user 

can control the light (DMX devices) via a smartphone and the DUODMX GATEWAY. 

All DUODMX GATEWAY variants (as of firmware 2.2.0.0) are compatible with the DUO DMX APP. This 

allows for an additional control (via the smartphone) in addition to the building automation system.  

The configured lamps and scenes are automatically loaded by the DUODMX GATEWAY. The lamps and 

scenes are, as usual, configured with the DMX-Configurator. 

A special feature in this context is the use of the DUODMX GATEWAY without KNX or EnOcean so that 

connections with KNX group addresses and EnOcean profiles are not necessary. Only the lamps are 

defined and the scenes created. 

The DUO DMX APP is downloaded and installed via the Google Play Store or the Apple App Store. 

6.1 CONFIGURATION OF LAMPS 

To allow for the DUO DMX APP to control the lamps, it is necessary to know which DMX channels are 

assigned to a DMX lamp. The lamps are defined in the DMX-Configurator under Settings/device 

management. The procedure is the same as the procedure already described in this manual. 

The precise procedure is described in chapter 5.4.13 on page 32. 

6.2 CONFIGURATION OF THE SCENES 

The scenes are also created in the same way as for the use without the APP. Scenes are centrally created 

with the DMX-Configurator and can be accessed by the APP (in addition to the group addresses and 

EnOcean profiles). 

The configuration of the scenes is explained in detail in the chapters 5.4.3 to 5.4.5 on the pages 24 to 

26. 

6.3 HOW TO USE THE APP 

After having started the APP, the start menu of the APP is displayed (see Figure 59: DUO DMX APP ). 

The following entries are available on the start page: 

 Demo. Starts the demonstration even without an existing DUODMX GATEWAY. 

 Enter Gateway manually. Here, the IP address of the DUODMX GATEWAY can be entered 

manually in case that the DUODMX GATEWAY cannot be found automatically. 

 Start Gateway search. Search for DUODMX GATEWAYs in the local network. 

 Available Gateways. Here, the available DUODMX GATEWAYs are listed. 
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 > Connect. With this button, the selected DUODMX GATEWAY is connected to the control. The 

selected DUODMX GATEWAY is marked in the list at the right margin with an orange line. 

6.3.1 CONNECTING THE APP WITH THE DUODMX GATEWAY 

Approach: MANUAL. Enter Gateway manually. 

If the IP address of the DUODMX GATEWAY is available, it can be entered manually. (See Figure 60: 

Manual IP address Input) 

Approach: AUTOMATIC. Start Gateway search. 

The DUODMX GATEWAY also has a Discovery function. It is used for automatically searching for 

DUODMX GATEWAYs. (See Figure 58: DUO DMX APP Search process activated) 

Select the DUODMX GATEWAY to be controlled by clicking on it. The orange line at the right side of the 

list shows the selected DUODMX GATEWAY. 

Press > Connect to connect the APP with the DUODMX GATEWAY. The configuration data are 

automatically downloaded in this process.  

  

Figure 59: DUO DMX APP Gateway selection Figure 58: DUO DMX APP Search process activated 
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Figure 60: Manual IP address Input 
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6.3.2 CONTROL OPTIONS OF THE APP 

After the connection, the following options are available (see left image on this page). 

 Control of scenes 

A scene (also referred to as a sequence) is the course of settings for lamps. Scenes can be 

started or paused. 

 Control of lamps 

This option allows the direct control of lamps. One-channel lamps are dimmed. RGB-lamps 

or RGBW-lamps are controlled by a colour circle (colour picker). It is also possible to directly 

pick colours via four fields. (See page 67) 

 Moods 

Under this point, Moods are created, picked and managed. (See page 68) 

 Settings 

The configuration includes the following options:  

o activating the DEMO project  

o saving the connected DUODMX GATEWAYs  

o providing four favourite colours 

 Information “About the DUO DMX APP” 

Among others, the APP version is displayed here (figure see next page).   

Figure 61: DUO DMX APP Start page Figure 62: DUO DMX APP Settings 
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Figure 63: About the DUO DMX APP 
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6.3.3 PREPARING THE LAMPS AND SCENES 

Using the DMX-Configurator, lamps are defined and scenes are created. They are read out by the 

DUODMX APP when being connected.  

However, what is missing regarding the control of the lamps and scenes via the APP is the information 

on which DMX output (DMX world) the individual lamps are to be connected and the scenes are to be 

reproduced. This information is not available for the APP; it must be defined by the user once (in the 

APP).  

If an entry which has not yet been assigned to a DMX output is selected for the first time under the 

menu item Lamps or Scene, the selection menu pops up in which the DMX output can be assigned (left 

figure; output not yet selected). 

The following figures (one for lamps, one for scenes) show the selection menu. Output 1 and Output 2 

stand for the DMX outputs (DMX world) at the DUODMX GATEWAY. The selected output is indicated by 

the orange marking. 

NOTE: If the selection of the DMX output must be changed, the selection can be opened again by a 

long click on the lamp or the scene.  

Figure 65: Assigning a scene to a DMX output Figure 64: Assigning a lamp to a DMX output 
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6.3.4 CONTROLLING THE LAMPS AND SCENES 

After having assigned the DMX outputs (see previous chapter), the lamps and scenes can be accessed 

directly (Figure 61: DUO DMX APP Start page see orange arrows). 

To be found under the inputs (Figure 61: DUO DMX APP Start page) 

Control of lamps and 

Control of scenes  

The figures on this page show the available lamps (figure to the right) and scenes (figure to the left) of a 

project example.  

The scenes are started by clicking on them. The figure on the right side shows which scenes have been 

started. (grey line = not active; orange line = active; see orange arrow) 

NOTE: If the DMX output must be changed, the selection can be opened again by a long click on the 

lamp.  

Figure 67: Control of lamps Figure 66: Control of scenes 
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Figure 68: Lamp 1 channel (only dimming) Figure 69: RGB(W) lamp 3(4) channel 

To control the lamps, however, a screen opens up. There are two different control options.  

 1. Screen for the control of RGB or RGBW lamps (controlled by a colour circle; Figure 69: 

RGB(W) lamp 3(4) channel 

 2. Screen for the control of an individual channel (dimming with a slider; Figure 68: Lamp 1 

channel) 

NOTE: In case that one of the favourite colours has to be changed, the colour can be directly changed 

in the “Lamp control”. It is not necessary to switch to the settings of the APP. To do so, the currently 

pre-set colour is applied by pressing and holding one of the four fields of the favourite colour for a 

longer time (see Figure 69: RGB(W) lamp 3(4) channel). 
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6.3.5 MOODS FUNCTION 

With the Moods function, colour impressions are copied directly from your own pictures to the lamp 

settings. To do this, a picture is selected in the App, and five different colours are selected with a touch 

of your finger. These colours can be used as a sequence with adjustable speed or as individual colours.  

The configuration and control are accessed via the Moods entry (Figure 61: DUO DMX APP Start page 

see green arrow). 

6.3.5.1 ADDING MOOD AND SELECTING COLOURS 

To select a picture for a new Mood, press + to open the selection dialogue (see Figure 70: Adding 

Moods).  

Once the picture is selected, the APP shows the selected picture including the five automatically placed 

circles (see Figure 71: Selecting colours). These circles can now be shifted to the desired colours on the 

picture. 

The bar above the picture shows the five currently selected colours. They will be reproduced in this 

order (from left to right) as a sequence.  

Figure 70: Adding Moods Figure 71: Selecting colours 
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The slider above the picture controls the speed of the sequence. 

The three symbols below the picture have the following function:  abort,  apply,  open colour 

selection (see picture Figure 72: Creating Moods without a picture). 

 

Selecting your OWN COLOURS: 

With the colour selection ( ) you can directly define the desired colours, i.e. create a sequence 

without a picture. With this symbol, the selected picture is faded out and a colour circle is displayed. 

Press the  icon to return to the picture selection. 

If you want to change one of the five favourite colours, you must at first select the favourite colour to 

be changed (orange arrow; the selected favourite has a white outline) and then set the new colour in 

the colour circle (green arrow). 

Press Apply ( ) to close the colour selection. 

 

  

Figure 72: Creating Moods without a picture 
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6.3.5.2 OPERATING MOODS 

Click on the Moods to select them on the Moods Screen (see left figure). A submenu opens up where 

the Moods can be changed ( ) or deleted ( ). Press the symbol ( ) to open the Moods control 

(right figure). 

  

Figure 73: Overview of Moods Figure 74: Configuration of Moods 
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Once you have opened the Moods control, a list of all configured DMX lamps appears. After having 

selected the lamp, the colours of the Mood are shown. The selected colour is now directly reproduced 

on this lamp. 

Press the Play symbol to start the sequence and reproduce the colours of the Mood one after the other 

(right figure). 

Note: The following also applies in this case: For the first access, you must define which lamp is to be 

reproduced on which DMX output. See left figure. 

  

Figure 76: Assignment of the DMX output Figure 75: Selecting colours 
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7 TRIGGERING SCENES VIA THE BUTTON INPUT 

 

It is possible to trigger manually defined light scenes via the potential-free input. To do this, the switch is 

connected to the third and fourth pole of the 6-pole plug-in screw terminal (at the side of the network 

connection, see figure). 

For the potential-free input of the REG variant, the switch is also connected to the third and fourth pole 

of the 6-pole plug-in screw terminal. 

Once the switch has been closed or opened, the DUODMX GATEWAY triggers the light scene with the 

corresponding name. 

The names of the light scenes are provided as follows and assigned to the DMX output: 

Contact opened: 

Scene name "switch_on_1"   ->  Reproduce scene on DMX interface 1 

Scene name "switch_on_2"   ->  Reproduce scene on DMX interface 2 

Scene name "switch_on_12"   ->  Reproduce scene on DMX interfaces 1 and 2 

Contact closed: 

Scene name "switch_off_1"   ->  Reproduce scene on DMX interface 1 

Scene name "swtich_off_2"   ->  Reproduce scene on DMX interface 2 

Scene name "switch_off_12"   ->  Reproduce scene on DMX interfaces 1 and 2 

Note: Only one light scene each for the opened and closed status is permissible. 
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8 DMX PLUG/SOCKET PIN ASSIGNMENT 

 
 
3-pol. XLR Plug (Front view) 
1 – Ground/Screen 

2 – DMX  – 

3 – DMX + 

 
 
 
 
 
 
 
 
 
 
 
 
3-pol. XLR Socket (Front view) 
1 – Ground/Screen 

2 – DMX  – 

3 – DMX + 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
DUO DMX Gatway (Front view) 
1 – Ground/Screen 

2 – DMX  – 

3 – DMX + 

 
 
    3    2    1    3     2    1 
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9 FIRMWARE UPDATE 

To update the DUODMX GATEWAY firmware, please proceed as follows: 
 

 Use an empty SD card and import the current firmware file. The firmware file must be named 
dmxknx.fir. 

 Disconnect the DUODMX GATEWAY from the power supply and insert the SD card in the SD 
card slot.  

 Press the Button and keep it pressed while reconnecting the power supply. 
 Wait until the LED of the DUODMX GATEWAY no longer flashes; now you may release the 

button. 
 Remove the SD card and restart the device by disconnecting and connecting the power supply. 
 After the successful reboot, the device is available with the current firmware.  

The project data remain save. 
 
 
 

10 CREATING ESF DATA 

To create the desired ESF data for the connection in the DMX-Configurator, you have different options. 
 
Creating ESF data from the EIBPORT 
As of the firmware version 1.0.2 (version 3), the EIBPORT offers the option of exporting its address data 
as ESF file, to do this, switch to the menu Editor > Extras > ESF Upload & data administration. Create the 
desired addresses in EIBPORT and export them as ESF file.  
 
Creating ESF data with ETS 
To create the desired data with ETS, you require the application of a device which can handle the data 
types 1 bit or 1 byte. Then connect the desired addresses and export the data as ESF. 
 
Creating your own ESF file 
Search an existing ESF file which includes 1-bit and 1-byte communication objects, and open the file 
with a text editor. On the basis of the syntax, you can change the file so that it complies with your 
desired addresses and data types.  
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11 SUPPORTED ENOCEAN PROFILES 

Here is the list of "EnOcean Equipment Profiles" (EEP) that can be used with the DUODMX GATEWAY 
 
 

F6-01: SWITCH BUTTONS  

F6-01-01: Push Button  
 
 

F6-02: ROCKER SWITCH, ROCKER  

F6-02-01: Light and Blind Control - Application Style 1 
F6-02-02: Light and Blind Control - Application Style 2 
F6-02-03: Light Control - Application Style 1 
F6-02-04: Light and blind control ERP2  
 
 

F6-03: ROCKER SWITCH, 4 ROCKER 

F6-03-01: Light and Blind Control - Application Style 1 
F6-03-02: Light and Blind Control - Application Style 2 
 
 

F6-04: POSITION SWITCH, HOME AND OFFICE APPLICATION 

F6-04-01: Key Card Activated Switch 
F6-04-02: Key Card Activated Switch ERP2  
 
 

F6-05: DETECTORS 

F6-05-00: Wind Speed Threshold Detector 
F6-05-01: Liquid Leakage Sensor (mechanic harvester) 
F6-05-02: Smoke Detector  
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© Copyright 2019 BAB TECHNOLOGIE GmbH 
 
Any information contained in this manual has been compiled with utmost care and to the best of our 
knowledge. However, mistakes cannot be completely ruled out. 
Therefore, we need to point out that we neither can give a guarantee nor assume the legal 
responsibility or any liability for consequences resulting from incorrect information. This document does 
not contain any guaranteed properties. The manual and the properties are subject to change at any 
time and without prior notice. 
 
The use of the devices in applications where the safety of people is dependent on their functioning is 
not permitted. 


